
 HyperSnap-DX    Contents    
Note: all references to HyperSnap-DX Pro are not valid for DEC Alpha versions of this software. On DEC Alpha processors, only 
Basic version of HyperSnap-DX is available.

      Overview a good place to start, with a listing of items of special interest to all, with 
hypertext jumps to further information

      Tutorial a step-by-step lesson on how to capture, edit, and save a screen shot

      QuickHelp a convenient hypertext-linked listing of each menu item for quick 
reference and to conveniently learn all about HyperSnap-DX. Also 
accessible from the QuickHelp toolbar button above.

      Tips & Hints suggestions for the best use of the program and how to make those difficult
captures.

      Advanced HyperSnap-DX command line option documentation

     What's New the latest list of enhancements to HyperSnap-DX, including information 
about the  version 

      Support Troubleshooting, and how to contact the author for technical support

      Registration how to purchase HyperSnap-DX

       Other Software additional software products from Hyperionics

    
Software by Greg Kochaniak

Check out HyperCam, another quality product from Hyperionics, that allows you to record the action from
your Windows 9x, 2000 or NT screen as an AVI movie. You can include cursor movements and sound, and 
take advantage of many other options, designed with the same care as HyperSnap-DX. Find out more 
about HyperCam and download a trial version from our web site at http://www.hyperionics.com

Scribbler - software product sold by Hyperionics. This is a unique DHTML, JavaScript and VBScript 
editor, written by Cream Software



 HyperSnap-DX  Feature Overview
Note: all references to HyperSnap-DX Pro are not valid for DEC Alpha versions of this software. On DEC Alpha processors, only 
Basic version of HyperSnap-DX is available.

HyperSnap-DX brings professional quality, convenient Windows 9x, 2000 and NT screen captures to your 
fingertips. It was designed for ease of use, with powerful and useful features to aid the professional as well 
as support the needs of the occasional user. Use it just a few times -- you'll find it to be indispensable.

Click on any of the buttons or help hotspots below to learn more about the HyperSnap-DX feature 
mentioned.    

    Save your image as a BMP, GIF or JPEG file. GIFs can optionally be interlaced and include transparent 
backgrounds, and HyperSnap-DX can create progressive JPEGs, perfect for World Wide Web page use. Choose 
your color depth for BMP captures, too.
    The 

 version adds TIFF, LEAD (cmp), CALS, CCITT Fax (fax), Encapsulated Postscript (eps), GEM Image (img), 
IBM IOCA (raw), Macintosh Picture (pic, pict), MacPaint (mac), Microsoft Paint (msp), OS/2 Bitmap (bmp), SUN 
Raster (ras), Targa (tga), WinFax (wfx), Windows Metafile (wfm), WordPerfect (wpg), Portable Graphics PNG, and 
Adobe PSD, many with optional sub-formats and variations, to the file formats that you can open and save. Use 
HyperSnap-DX for file format conversions and editing!
    Capture in DirectX or 3Dfx GLIDE Applications! Now you can make those special game and other captures 

you could never do before. Version 3.30 and higher can even capture screens from DVD player or other DirectX 
overlay based video software!
    Capture images from multiple monitors at once, when used on multi-monitor setups under Windows 98 or 

2000.
    Resize captures or image files you open in HyperSnap-DX when you use the 

 version
    Change the color depth of your image to 2, 16, 256, or 16 million colors, with eight dithering choices, or 

grayscale or halftone images when you use the 
 version

    Include the cursor image in your image to better display your product shot or call attention to a specific item.
    Use the built-in Crop feature to remove rectangular sections from within an image, or use conventional 

cropping for making final edits to your capture without transferring it to another program. And thankfully, 
there's an Undo feature to mitigate the "oops!" factor.

 Capture an image of an entire web page, file listing, or other scrolling windows, beyond the scroll bar by 
using the unique Auto Scroll Window capture option.

    The flexible and labor-saving Window capture option captures whole windows and smaller sections of 
windows, highlighting the boundries of each of your options, to make a quick and accurate capture without eyestrain
and further editing. 

    Minimize HyperSnap-DX to a system tray icon, ready for action with a convenient right-click capture menu.
    Choose your own HotKeys that quickly capture the entire Desktop, any Rectangle you outline, or the 

highlighted Window or Client, and automatically repeat the capture every x seconds or by using another HotKey.
    Automatically save each of your captures to a file by default -- you can even trigger new captures every x 

seconds and have the filename incremented.
    Print your capture direct from HyperSnap-DX -- it will expand the image to the size of the paper and 

margins that you set, print multiple pages, and even add a frame, reverse, or reduce the output to black and white!
    Drag and Drop files on HyperSnap-DX to open them!

There's so much more... just use HyperSnap-DX. It will quickly become your tool of choice.

HyperSnap-DX is marketed through the distribution of this fully functional trial version; its only limitation
is that the captures that are produced are "branded" to indicate its trial use. After a reasonable time period 
has passed, giving you the opportunity to use this software (a maximum of thirty days is suggested as 
appropriate), you must purchase this software to continue to use it legally. It must otherwise be removed 
from your machine. Purchase information can be found under Registration.



 QuickHelp displays an image of all the menu options that you can click for explanations of their use. 
 The HyperSnap-DX Tutorial can be a great way to get to know HyperSnap-DX



 HyperSnap-DX    QuickHelp
Note: all references to HyperSnap-DX Pro are not valid for DEC Alpha versions of this software. On DEC Alpha processors, only 
Basic version of HyperSnap-DX is available.

This menu listing conveniently tells you everything you need to know about HyperSnap-DX's many 
features. It serves as both as a quick introduction to all HyperSnap-DX can do to make screen captures 
easier, as well as an ongoing reference when required.
Click on any menu selection for a complete but concise explanation. 

 File
Open 
Save As 
Acquire 
Select Source 
Page Setup 
Print 
Send by Email 

 Edit
Copy 
Paste 
Clear 
Copy Format 
Undo 

 View
Full Screen 
Previous File 
Next File 
Menu
Status Bar
Tool Bar 

 Capture
Full Screen 
Virtual Desktop
Window 
Active Window 
Active Window without Frame 
Region 
Pan Last Region
Repeat Last Capture 
Enable Special Capture 
Quick Crop & Scale
Quick Copy 
Quick Print 
Quick Save 
Auto Scroll Window 
Include Cursor Image 
Restore After Capture 

 Image
Crop 
Crop Out Rectangle 
Select Background Color 
Gamma Correction
Invert Black and White
Change Image Resolution
More Image Functions 
Resize 
Color Resolution 
Grayscale 
Halftone
Mirror Image
Rotate Image

 Options
Configure Hot Keys 
Hide Help in Region Capture 
Startup and Tray Icon 
Set Auto-Scroll Refresh Time 
Default Image Resolution

Menu items shown in blue are included in the  Version of HyperSnap-DX, a free upgrade if you 
purchased the basic HyperSnap-DX.

 Please note that keyboard shortcuts are available for many menu entries, but are omitted from this listing for space
considerations and the fact that you can configure certain hot keys to your own preference. Keyboard shortcuts are 
shown on the actual menus.

 Feature Overview Page



Open (File)
Open a GIF, BMP, or JPEG file.

 The 
 version adds TIFF, LEAD (cmp), CALS, CCITT Fax (fax), Encapsulated Postscript (eps), GEM Image (img), 

IBM IOCA (raw), Macintosh Picture (pic, pict), MacPaint (mac), Microsoft Paint (msp), OS/2 Bitmap (bmp), SUN 
Raster (ras), Targa (tga), WinFax (wfx), Windows Metafile (wfm), WordPerfect (wpg), Portable Graphics PNG, 
Adobe PSD, and AVI video file formats to the available options.
Page Number to Open is also added with the installation of the Pro version. The option is applicable only 
when file types that support multiple images, like animated GIFs, TIFFs, AVIs, etc., are opened. When you 
select such a file, the total number of pages is displayed adjacent to the field, into which you can enter the 
image number you wish to open.

 You can also open these file formats simply by dragging and dropping a file to HyperSnap-DX or specifying a 
filename in a command line.



Save As (File)
Save File As Type lets you choose from Windows Bitmap (bmp, dib), GIF, or JPEG (jpg) file formats.

 The 
 version adds TIFF, LEAD (cmp), CALS, CCITT Fax (fax), Encapsulated Postscript (eps), GEM Image (img), 

IBM IOCA (raw), Macintosh Picture (pic, pict), MacPaint (mac), Microsoft Paint (msp), OS/2 Bitmap (bmp), SUN 
Raster (ras), Targa (tga), WinFax (wfx), Windows Metafile (wfm), WordPerfect (wpg), Portable Graphics PNG, and 
Adobe PSD file formats to the available options.
Sub-Format will gray out or become active as you choose each File type. You may select from the available sub-
formats to more fully tailor the output format to your needs.
Bits Per Pixel allows you to specify the color resolution of the image, or let the program choose by 
checking off Auto Select Best. If you select color resolution manually, and it's 8 bits per pixel or less, you 
may also select Optimized or Standard Windows color palette.
Quality Factor will gray out or become active depending on whether the option is applicable to the file 
format chosen. It typically adjusts the compression level of the format, and results in a compromise 
between quality and size.

 Note that the checkbox selections on the right side of the dialog will gray out and change depending on the file 
format you choose. They allow you to select from various options available depending on the file format:

Interlaced applies to GIF files, which allows for gradual loading by a browser when shown on the
web.
Transparent, a GIF format option, will prompt you to specify your transparent color choice.
Progressive is for JPEG files, which also loads gradually in a browser when displayed in a web 
page.
Append is applicable to the multi-page file formats added with the Pro version. When you save a 
file, if append is checked, the image is added as a new page in that file. If not, the entire file will be
overwritten by that image.



Acquire (File)  
Acquire activates HyperSnap-DX's TWAIN-compatible interface, so you can use a scanner, digital camera, 
or other device to capture an image.
The Select Source option may be used to specify the desired TWAIN device 



Select Source (File)  
The option lets you specify the TWAIN device that you want to use when you use the Acquire function.
If no items are available, please consult your TWAIN-compatible device's manual's installation instructions.



Print (File)
Selecting Print will provide you with the familiar Windows print dialog.



Page Setup (File)
Paper lets you choose the size and source.
Colors checkboxes offer three options:

· Invert Black & White is a great option for creating negative transparencies of screen shots -- saves on toner 
or ink, too, if your capture has lots of dark areas.

· Black and White Only eliminates grayscaling for a cleaner look in some instances.
· Draw Frame adds a thin line frame around the image for that finished look.

Orientation lets you choose from Portrait, Landscape, or let HyperSnap-DX select the best fit.
Margins can be modified for all four sides of your captured image, and HyperSnap-DX can center the 
image. 
Center Image on Page will make the image be printed in the center of the page, instead of in the left top 
corner.
Scaling offers the option to scale to a specific percentage more or less than the original, or let HyperSnap-
DX Auto-fit the image to fill the page within your specified margins. 
HyperSnap-DX will print multiple pages for long bitmaps if scaling options demand it; images too wide 
will automatically be cropped, printing only the image area that fits on the page.
Header and Footer allows you to add text that will be printed above and/or below the picture.

 If currently a popup window, open this topic as a regular Help page.



Header and Footer (File/Page Setup)
Pritn Header and Footer dialog, available from Page Setup, allows you to enter a text, which will be 
printed above (Header Text) or below (Footer Text) of the picture itself. You may select the font size, in 
points (1 “point” = 1/72 of an inch) and alignment of the text. You can insert some macros inside the text, 
which will be expanded to current date, time, user name (as known to Windows operating system), file 
name or path to the picture file. These macros are listed on the right side of the Print Header and Footer 
window.



Send by Email (File)
This function will let you send the picture currently displayed in HyperSnap-DX window by email to 
someone else. You may choose different file formats and file name. If in doubt, select GIF format, as it is 
one of the most popular, and typical screen captures saved in this format produce the smallest files.

Specify the file name using a word or a short phrase (a maximum of 64 characters) that describes your 
picture, or retain the default SNAP file name if it doesn't matter. Do not add a file extension (a period with 
anything after it) or the directory where the file should be saved. Your email software will select them 
automatically, and delete the file when it has been sent.



Copy (Edit)
Copy the current capture to the Windows clipboard



Paste (Edit)
Paste the contents of the Windows clipboard into HyperSnap-DX.



Clear (Edit)
Clear the current capture from HyperSnap-DX.



Full Screen (Capture)
Select to capture the entire screen (all you can see on the screen)

 Configure Hot Keys



Virtual Desktop (Capture)
Select to capture the entire desktop, including multiple monitors, if used on your system.

 Configure Hot Keys



Region (Capture)
When clicked, a large cross cursor (+) will appear. Click using your left mouse button to indicate where you
want to start the capture area, and then release it. Drag the outline to enclose the area you want to capture, 
and click the mouse button again. The size (in pixels) of the capture will be shown within the area.
While activated, the following additional useful options apply, and will be shown in a small window as a 
reminder. They can be toggled off using F1 or by the option: Hide Help in Region Capture.

USE MOUSE OR THE FOLLOWING KEYS:
F1: Toggle help text and zoom on/off
Arrows: more pointer by one pixel
Shift-Arrows: move pointer by 10 pixels
Ctrl-Arrows: move pointer to an edge
Esc or Right Button: abort operation
Enter or Left Button: accept this position
+: hide/show mouse pointer
X, Y: Lock/Unlock X or Y axis movement

once the first anchor point is established, these tips are added:
-: hide/show rectangle size in pixels
Tab or Home: switch rectangle corner

Note: F1 key may be now changed to something else (Options/Hot Keys menu), if F1 interferes with other applications.
The points are now picked upon release of left/primary mouse button, not upon press as in versions before 3.40.

 Configure Hot Keys



Pan Last Region (Capture)
This capture function will display for you a rectangle on the screen, of the same size as your previous 
capture. You can then move this rectangle on the screen with the mouse and arrow keys, to capture another 
region of the screen with the same size.
Your mouse cursor will be in one corner of the rectangle, and the small area around it will be displayed in 
the zoom window. If you need to get precisely another corner of the rectangle, press Tab key on the 
keyboard. This will move the mouse cursor to the next corner of the rectangle, in clockwise direction. 



Window (Capture)
As you move your mouse, a blinking frame will appear around the 
target object. You can capture an entire window or just a predefined 
area within a window.
Move to the window you want to capture, and click with your left mouse 
button to select and capture the region around which the blinking frame 
surrounds.
Click your right mouse button to abort this function.

 As you maneuver for your capture, if the highlight 
includes only a sub-window within a window you want to capture, try 
clicking on its title bar or frame.

 Active Window /Active Window without Frame (Capture) 
 Configure Hot Keys 



Active Window / Active Windows without Frame (Capture)
When either option is clicked, the active window is captured, with or 
without its framing.
If you prefer, You can capture a sub-window (an area within a window) 
using the Window (Capture) option.

 Window (Capture)



Enable Special Capture… (Capture)
HyperSnap-DX can capture screens from applications and games using MS DirectX/Direct3D technology 
or 3Dfx Glide drivers, in Windows 95, 98 and NT. It will even try to capture screens from a DVD player or 
other video software, that is using DirectX screen overlay technology.
To capture screens from the game or video hardware, click on the Capture menu item in HyperSnap-DX
and click on Enable Special Capture. HyperSnap-DX will now display a dialog box with extra options that 
you may set up, and will remind you of the hot key assigned to executing Direct X and Glide captures. 
Run the program or game/video normally, and whenever you're ready to capture the screen, use the hot key 
assigned to DX captures (Scroll Lock, by default). A short beep will usually sound to confirm the capture. 
HyperSnap will not force itself to the foreground interrupting the game, so if you want to see it, you have to
use Alt-Tab key in the game to put it in the background and go back to regular Windows. Note: for some 
games Alt-Tab does not work; you will have to exit the game completely to return to the Windows desktop.

 You may choose the Quick Save or Quick Print options in HyperSnap-DX before opening your Direct-X 
application. Now, each time you capture a screen, it will be saved to a file with a sequential number (if you used 
Quick Save correctly), or printed to the printer. You don't have to "Alt-Tab" out of the game to have your picture 
saved or printed.
If you used Quick Save with the option to auto-number files, you may view them all easily once you exit the game. 
Just bring HyperSnap-DX to the front and press Page Up or Page Down key to see the previous or next file saved. 
You may also view your pictures in full screen mode by selecting Full Screen item from the "View" menu.

 You may also use the Repeat Capture feature from the Quick Save dialog - just enter a non-zero value into the 
corresponding field there. You may, for example, enter 10 to have the capture repeated every 10 seconds. Then 
switch to or start the Direct-X application, and move to the first screen you want to capture. Press the DX capture 
hot key and you will hear your action confirmed by one beep. From then on, auto-capture will be repeated every 10 
seconds. No more beeps are emitted; the files are captured and saved quietly. Press the same hot key again to stop 
auto-capture, and you should hear 3 beeps confirming the cancel of auto-capture.

 You may change the hot key for special captures through Options | Configure Hot Keys

 Configure Hot Keys
 Tips and Hints - How to Capture games using Microsoft DirectX or 3Dfx Glide technology

 If currently a popup window, open this topic as a regular Help page.



Configure Hot Keys (Options)
Hot Keys is a convenient feature of HyperSnap-DX. Even when minimized, the program stands ready to 
accept your hot key combination to immediately capture a screen! The Hot Keys (keyboard shortcuts) for 
screen captures can easily be customized to your preference.

Clear All deletes all Assigned Keys (Hot Keys)
Defaults returns all Assigned Keys to their original states
Revert returns all Assigned Keys to the assignments that were in effect when you opened the dialog
Handle Print Screen Key if enabled, HyperSnap-DX uses Print Screen key to initiate a full screen capture.
This allows you e.g. to capture Screen Savers, even the ones working in DirectX or Glide mode, if "Special 
Capture" is also enabled. All other hot keys turn the screen savers off, so they can't be used to capture them.
Enable hot-keys turns the function on and off

Click on the button next to the function you wish to change, then execute the key combination you want for
that function, and then click on OK. Your new Hot Key assignment will also be shown in the HyperSnap-
DX menu option.

 Be sure not to assign Hot Key combinations that might conflict with another program. To prevent any problems 
with specific programs, you can temporarily disable HyperSnap-DX's hot keys by deselecting the Enable Hot Keys 
option.

 Repeat Last Capture 
 Quick Save  for information on Stop Auto Capture



Hide Help in Region Capture (Options)
When checked, this option hides the "help box" that appears during a Region Capture. It can be viewed by 
toggling it using the F1 key.

 Region (Capture)



Startup and Tray Icon (Options)
Under this Options menu item you can make HyperSnap-DX to auto-start with Windows and decide if its 
window should be originally minimized to the task bar (or tray), or fully opened. You can also select an 
option to display only a tiny icon in the system tray when iconized (the System Tray is the area to the right 
or bottom of the task bar, where often time, volume control and other icons are displayed). Use this option 
if you think that the full size icon of HyperSnap in the task bar is too obtrusive.
Once you have HyperSnap-DX camera icon in the tray, you may click it to open the HyperSnap-DX 
window, or right-click on it to get instant access to the program's Capture menu.
The extra Do not exit when clicked on “Window Close” [X’ button is valid only if you select the Display 
tray icon only… option first.



Set Auto-Scroll Refresh Time (Options)
This option lets you fine-tune the timing for the Auto Scroll Window. Recommended values are shown in 
the dialog.



Menu (View)
Hide the HyperSnap-DX menu using this menu item or the Control-M shortcut, which will be necessary to 
use when the menu is hidden.



Full Screen (View)
You may view the current capture full-screen by clicking on this menu item or using the hot key 
combination Ctrl-PageDown. Striking any key or a mouse click will return you to the normal HyperSnap-
DX view.



Previous File / Next File (View)
You can quickly browse through a directory of image files, in alphabetical order, using HyperSnap-DX. 
Open a file in the directory using File | Open and then use the menu items or, more conveniently, the 
PageUp and PageDown hot keys. HyperSnap-DX can open any of the supported file types and display them
for you

 Remember, You can save any format to any other supported format, chosing the options you want, so you can use
HyperSnap-DX to convert graphics for use on the web and elsewhere.

 SaveAs



Menu (View)
The menu can be hidden by unchecking the View|Menu option. Once hidden, Control-M will return it to 
view.



Status Bar (View)
Check or uncheck this item to display or hide the status bar at the bottom of the window.



Tool Bar (View)
The HyperSnap-DX toolbar makes frequently-used menu items more conveniently available. Tooltips 
identify each button.
The toolbar can be dragged and docked to any side of the HyperSnap-DX window, as well as be placed as a
free-floating toolbar for your convenience.
Unchecking the view option will remove the toolbar.



Copy Format / Bitmap Copy Options (Edit)
This option affects the number of colors and the type of bitmap pasted to the Windows Clipboard when you
use the Quick Copyfunction. 
You may choose the bitmap format to place on the Windows Clipboard by selecting DIB (Device 
Independent Bitmap) or DDB (Device Dependent Bitmap), or Copy Both. Some programs, especially older
ones, can have difficulties with DIB only, so we advise that you choose Copy Both.
You may want to leave Auto select checked to save your capture in the current display mode. However, 
you can select from Monochrome, 16, 256, or 16 million colors by deselecting Auto select and clicking on 
any other choice.Your choice is saved between sessions.

 This option can save you steps if you are in a higher color mode, like True Color or just 256 colors, yet want to 
paste a bitmap into a document using the less space-consuming 16 color or other mode.

 Quick Copy



Quick Crop & Scale (Capture)
Enable this function to automatically crop, or scale, or both, for each newly captured image. The crop and 
scale operations are applied before the image is printed, copied to clipboard or saved (for other “Quick” 
operations).

This function may be also applied to “Special Captures” from games or video, DVD software. It is 
particularly useful when capturing e.g. DVD pictures. Sometimes the picture you capture from a DVD or 
other video surface, may have a wrong aspect ratio, or even be repeated several times in the memory buffer 
that HyperSnap-DX reads. You can then capture such image once, enable “Quick Crop” to cut out the extra 
images, and then apply the correct scaling factor to have the image of correct proportions. Once set, the 
cropping and scaling will be applied to all other capture operations, until you disable or change them.

Crop Image – enable this box when you need to auto-crop each capture, and then define the top-left corner
coordinates (in pixels) plus the width and height of the area to be cropped. You can also click on the 
Digitize from Image button, and select the region you need graphically. This button will be enabled only if 
you have some image displayed in HyperSnap-DX window.

Scale Image – enable this box if you need to auto-scale each image (after the eventual crop operation, if 
enabled). You can either scale the image to a constant pixels size. The Keep Aspect check-box is enabled 
only if you specify both width and height in pixels. If turned on, the image will be scaled so that it would fit
inside a box of the pixel size you specified, extending to either its full width or height, but not beyond that 
box, and keeping the pictures original aspect ratio. If you turn the Keep Aspect button off, your image will 
be scaled to the exact width and height that you specified, and the image proportions may be distorted. 
If you use the scale factor options, the image width and/or height will be multiplied by the numbers you 
entered. The value of 1 (one) will not change the dimension at all. The Keep Aspect box is then disabled, if
you want to keep the original image proportions, you must enter the same scaling factor for both width and 
height.    



Quick Copy (Capture)
Click this option to automatically have your capture sent to the Windows Clipboard. The option is toggled 
on and off; when checked, the option is activated

 Copy Format



Quick Print (Capture)
Quick Print automatically sends your capture to your printer. The options selected in the Page Setup dialog 
will affect the output.
The option is toggled on and off; when checked, the option is activated

 Page Setup



Quick Save (Capture)
Quick Save, when selected (check mark appears next to option), will automatically save your capture using 
any of the supported file formats. A dialog appears when you check off the option.

Prompt for name on each capture, when checked, will do exactly that.

Auto Save to can contain a file name of your choice. When you click on Change, the Save As dialog 
window is shown, which allows you to change the file name and choose the format, color depth, and other 
characteristics for the file. 

Increment file name, when checked, will cause HyperSnap-DX to save the files to the file name you 
choose, incrementing the number within the range you specify in the "start at" and "stop at" blocks.

Repeat first capture every [      ] seconds, will be activated if you enter a number (other than zero) in the 
and check the Quick Save option under the Capture menu. HyperSnap-DX will then automatically save a 
screen capture until you tell it to stop, using the "Stop Auto Capture" hot key. If you change the area that 
you are capturing without stopping Auto Save, it automatically switches to capturing the newly defined 
area. You may also optionally check the “Continue on Error” box to make HyperSnap-DX ignore file errors
and not abort Quick Save function. This may be useful, for example, if you want to continually take screen 
shots and push them to a WEB server, ignoring the occasional “file busy” errors.

 These HyperSnap-DX functions are great for producing graphics for manuals or other instructional materials, to 
show and teach a series of steps within a program window. Include the cursor for extra emphasis on specific areas.

 If Quick Save is enabled, and you open the Capture menu to change something in saving, clicking on Quick Save 
menu item will just uncheck it, and Capture menu must be opened again. To prevent this, hold the Shift key on the 
keyboard when you click on Quick Save menu item; this will always open the dialog.

 Configure Hot Keys

 If currently a popup window, open this topic as a regular Help page.



Auto Scroll Window (Capture)
This unique option gives you the ability to scroll down during a Capture|Window session, to capture data 
beyond what is immediately visible in a window with a vertical scroll bar.
Auto Scroll always starts from the top and moves downward. The following step-by-step instructions may 
help you understand how it works:

1. Set the target window containing the vertical scroll bar to the top of its page, or to the area where
you want to start capturing.

2. Move to the HyperSnap-DX window and click on Capture menu to be certain that the Auto-
Scroll Window menu item has a check mark to the left of it. If not, click on Auto-Scroll 
Window and reopen the menu again to verify that it does.

3. When you select Window from the Capture menu, HyperSnap-DX will disappear. Move your 
cursor to the window that you want to capture using auto-scroll, and click within the window. 
Then, observe how HyperSnap-DX automatically scrolls it as it captures. If you want to end the 
capture early, click again; otherwise wait until it it is finished.

Note: Auto-Scroll will not work with every application using a vertical scroll bar. Some applications 
interfere with the methods HyperSnap-DX uses to track the window. The system will display an error 
message to alert you. However, the most popular web browsers (Netscape Navigator/Communicator and 
Microsoft Internet Explorer) as well as most other programs we tested are compatible. 

 This function is ideal for capturing entire web page images, such as with Netscape or Internet Explorer, and file 
listings, too.

 If currently a popup window, open this topic as a regular Help page.



Restore After Capture (Capture)
When this option is checked, HyperSnap-DX will automatically restore itself to view after a capture, 
whether it is open or iconized.
If you uncheck the Restore after Capture option, the HyperSnap-DX window will remain or become 
minimized (stay in the task bar) after the snapshot.

 Sometimes you'll find it very handy to keep HyperSnap-DX minimized in the task bar. You may start your 
snapshots by clicking with the right mouse button on a minimized HyperSnap-DX window or by using hot keys, so 
it will print or copy images instantly.



Crop (Image)
Once you have captured or opened an image, you can crop it within HyperSnap-DX. Click using your left 
mouse button to indicate where you want to start the capture area, and then release it. Drag the outline to 
enclose the area you want to capture, and click the mouse button again. The size (in pixels) of the capture 
will be shown within the area.
While activated, the following additional useful options apply, and will be shown in a small window as a 
reminder. They can be toggled off using F1 or by the option: Hide Help in Region Capture.

F1: Toggle help text and zoom on/off
Arrows: more pointer by one pixel
Shift-Arrows: move pointer by 10 pixels
Ctrl-Arrows: move pointer to an edge
Esc or Right Button: abort operation
Enter or Left Button: accept this position
+: hide/show mouse pointer
X, Y: Lock/Unlock X or Y axis movement

once the first anchor point is established, these tips are added:
-: hide/show rectangle size in pixels
Tab or Home: switch rectangle corner

Note: F1 key may be now changed to something else (Options/Hot Keys menu), if F1 interferes with other applications.
The points are now picked upon release of left/primary mouse button, not upon press as in versions before 3.40. This 
allows you to easily pick e.g. left or top edge of the image: press the left mouse button, hold it down, go out of 
HyperSnap-DX window, and release there. This will pick the nearest edge of the image, or e.g. point (0, 0), if you go to 
the left and top of HyperSnap-DX window.

 You may wish to resize the HyperSnap-DX window or use the scroll bars to adjust your view to make cropping 
more convenient.

 Crop Out Rectangle 



Undo (Edit)
Image edits can be undone by making this selection from the Edit menu, or using the standard Windows' 
Ctrl-Z Undo hotkey.



Crop Out Rectangle (Image)
This feature lets you outline and remove a rectangular section of an image. The color that will replace the 
section can be chosen using the Select Background Color menu item.

 This tool is ideal for cropping out unwanted areas of a capture, such as cascading menus.

 You may wish to resize the HyperSnap-DX window or use the scroll bars to adjust your view to make cropping 
more convenient.



Select Background Color (Image)
A conventional Windows color selection dialog lets you specify your color choice to replace sections 
cropped from an image using the Crop Out Rectangle function, or in other functions that need to create 
some empty space (e.g. Rotate).



Gamma Correction (Image)
Gamma correction is an effect that affects most the colors of medium intensity, while leaving the brightest 
and darkest colors relatively unchanged. The values below 1 make the colors darker, and values above 1 
make them brighter. You can enter the value into the edit box and press the Apply button to observe the 
effect, or you can use the slider to see the effect immediately. When ready, click on the Done button.
The Undo command (Edit|Undo or Control-Z) can reverse the effect.



Invert Black and White (Image)
This menu item immediately reverses the black and white colors on your captured or loaded image.
The Undo command (Edit|Undo or Control-Z) can reverse the effect.



Image Resolution (Image)
The image resolution, usually expressed in number of dots per inch (dpi), affects the size of an image when it is 
printed or inserted into other documents (e.g. into MS Word document). If you change the resolution to a higher 
value, each pixel will become effectively smaller, so the whole image, when printed or inserted into some document,
will appear smaller as well – and vice versa. 

This setting does not affect the appearance of an image in HyperSnap-DX window. 

The default resolution to keep the original image size in printing and pasting to other documents should usually be 
96 dpi for high resolution monitors (1024x768 or higher setting), or 72 dpi for low monitor resolutions. However 
sometimes it may need to be modified. 

This function is accessible from two of the menus. In the Options menu, "Default Image Resolution" displays and 
sets the default resolution for all images that you will subsequently capture. In the Image menu, "Change Image 
Resolution" displays the resolution of the image currently displayed in HyperSnap-DX window, and allows you to 
modify the resolution for the current image only.



More Image Functions (Image)  
Additional image editing functions replace this menu entry when the Pro version is installed.



Resize (Image)  
Changing the physical size of your capture, or any image file you open in HyperSnap-DX, is easy and 
convenient.
The Slide Control interactively adjusts the sizing, displaying the results in the boxes.
Percent of Original Size; Width, in pixels; and Height, in pixels, can each be entered directly, and 
interact with each other by recalculating the other values. 
Keep Aspect, when checked, maintains the mathematical relationship between width and height, so your 
image remains in its original perspective.
Interpolate can help to improve the end product when both enlarging and reducing images by using 
mathematical formulas to fill in missing pixels. You may use the Apply and Revert buttons with and 
without the box checked to determine which variation suits your purpose.
The Apply and Revert buttons apply and reverse the effects of your actions of the current session.

   Requires   Pro version   



Color Resolution (Image)     
The color resolution of your capture can be altered upwards or downwards. Bits Per Pixel will be pre-
checked with the existing resolution of your image, and can be altered to any value shown:

1
 
=

2 colors

4
 
=

16 colors

8
 
=

256 
colors

2
4
 
=

16 
million 
colors

Dithering Method lets you choose your preferred method of distributing the color change in fewer number
of available colors. Choose from seven different popular dithering methods, or none. 
Palette box let's you choose a color table (palette) for pictures in 8 or less bits per pixel. Choose Optimized 
for the best picture appearance. If you want the picture to cause less palette changes when displayed on MS 
Windows running in 256 color mode, or in Netscape Web browser, choose the other options. You may also 
convert an imiage to black and white only.
The changes in the picture appearance are reflected immediately after you make your selection. You may 
use the Revert button at any time to go back to the original picture. 

 Requires   Pro version  



Grayscale (Image)     
This menu item immediately applies a 256 grayscale effect to your capture or loaded image.
The Undo command (Edit|Undo or Control-Z) can reverse the effect.

 Requires   Pro version  



Halftone (Image)  
This menu item immediately applies a halftone effect to your capture or loaded image, which may be useful
for low resolution printing and other purposes.
The Undo command (Edit|Undo or Control-Z) can reverse the effect.

 Requires   Pro version  



Mirror Image (Image)  
This menu item has two sub-items: Horizontal Mirror and Vertical Mirror. When any of them is applied, the
image changes into its own mirror image, as if the reflecting mirror was placed either horizontally or 
vertically.
The Undo command (Edit|Undo or Control-Z) can reverse the effect.

 Requires   Pro version  



Rotate Image (Image)  
This menu item rotates the image by any angle. You may enter the angle as a positive or negative number in
the range of -360 to 360 degrees. You can also use the slider to rotate the image and immediately observe 
the effect. Note that if the angle you enter is not a multiple of 90 degrees, some background around the 
image must be added, to fill the available space and make the image rectangular again. The color of this 
background can be changed with the Select Background Color function.
The Undo command (Edit|Undo or Control-Z) can reverse the effect.

 Requires   Pro version  



Include Cursor Image (Capture)
You may optionally include the image of your    current cursor in your capture.

 Use the cursor to highlight a point of    interest in your capture. HyperSnap-DX can capture some cursors that 
were previously thought invisible to all such programs. Due to non-standard ways in which cursors are handled by 
some programs, some custom cursors simply cannot be captured. 
In Windows 9x, the standard set of cursors is captured, as well as those defined by applications. In 
Windows NT, the cursor shape may be incorrect if it is within the console (DOS Prompt) window.



Repeat Last Capture (Capture)
Use this menu item or Hot Key to quickly repeat the last capture executed.

 This is a handy feature to take sequential or instructional captures of the same area, or redo the last capture with a
minor change.

 Configure Hot Keys



Enter License Number (Help)

Note: this subject does not apply to the owners of HyperSnap-DX commercial version.

You should enter this dialog only after you have received an email or letter from Hyperionics with your 
license information. If you do not have it yet, please click on Cancel button.
Your license letter will list your or your company name, the "Key" value, the type of the license and the 
number of licensed copies. Please enter all the data to the appropriate fields on the "HyperSnap-DX 
License" dialog. Please note also that your "key" string contains only capital letters from the English 
alphabet - there are no digits or other characters in it, except maybe for dashes or spaces to make the key 
entry easier. Whenever in doubt if O shape is "zero" digit, or the capital "O" letter, always enter a letter.
Please enter all strings (Register To: name and the key) exactly as spelled in your license letter from 
Hyperionics. Then click below in the "License Type" frame on the radio-button that marks the type of the 
license you have purchased. Most often it will be one or more "Single User" licenses. If this is the case, you
must also enter the correct "Number of Licensed Copies", that will be stated in your license letter.
After entering the above in most cases you may just click on OK button at the top right corner. If all was 
entered correctly, the "HyperSnap-DX License" dialog will just disappear. Your name and the license type 
should be listed in Help/About dialog. If you see a message saying "The license key you entered is 
invalid…", please click on OK button and verify once again if all the data was entered correctly. Make the 
appropriate correction and try again. If it still does not work, please contact Hyperionics for the correct 
license key.
Occasionally you may receive a temporary license from Hyperionics - e.g. for evaluation purposes, or to let
you work on an urgent project while your payment is in the mail or being processed. If you have a 
temporary license, you must click on the "Temporary License" check-box at the bottom of "HyperSnap-DX
License" dialog, and then enter the exact expiration date in the Year, Month and Day fields. If you neglect 
to do so, or enter a date that differs from the expiration date stated in your license message from 
Hyperionics, the license will not work.

 *If the registration name is not as requested or misspelled, please contact us promptly.



 HyperSnap-DX    Support
Note: all references to HyperSnap-DX Pro are not valid for DEC Alpha versions of this software. On DEC Alpha processors, only 
Basic version of HyperSnap-DX is available.

Troubleshooting Tips:

Sometimes, particularly on slower machines, a computer may not have enough time to refresh all the 
windows when you start the capture, and the HyperSnap-DX window disappears. In 32 bit 
environment applications are isolated from each other, and it's not possible to find out if all the 
windows are correctly refreshed. They are given only a limited time for the refresh, before 
HyperSnap-DX freezes the screen for the capture. If this happens, minimize the program window to 
the task bar first, and then start your capture with a hot key or the menu that pops up when you click 
using your mouse right button on the task bar.
For more tips, see the HyperSnap-DX Frequently Asked Questions list at Hyperionics Web Site - click 
on the appropriate "Discussions and FAQ" link on the left margin, and follow to HyperSnap-DX FAQ.

Support for HyperSnap-DX is close at hand. An e-mail message will get the quickest response. Be 
certain to provide as much background information as possible.

We also welcome your comments and input for future releases of HyperSnap-DX.

e-mail: gregko@hyperionics.com

Greg Kochaniak
Hyperionics
3146 Chestnut Street
Murrysville, PA 15668, USA

Check our World Wide Web site for the latest releases, announcements, and more information about 
HyperSnap: http://www.hyperionics.com



 HyperSnap-DX    Registration
Note: all references to HyperSnap-DX Pro are not valid for DEC Alpha versions of this software. On DEC Alpha processors, only 
Basic version of HyperSnap-DX is available.
HyperSnap-DX is fully functional software that allows you to "try before you buy" and, like all software 
companies, Hyperionics relies on your support for continued development. In order to remove our branding
from captures that are printed, saved, or copied, you must purchase the software. Single user registration is 
only $25.00; site licenses are available (see below).
The single registration fee will license one copy for use on any one computer at any one time.    You must 
treat this software just like a book. An example is that this software may be used by any number of people 
and may be freely moved from one computer location to another, so long as there is no possibility of it 
being used at one location while it's being used at another. Just as a book cannot be read by two different 
persons at the same time. 
When you register HyperSnap-DX, you will receive a code that enables full functionality and makes you 
eligible for priority technical support. You will also be able to obtain free updates of the program through 
our Web page (address below) that your registration code will similarly enable, good until the next major 
release. 
License cost:

Single 
licenses:

$25 each or $7.50 upgrade for registered users of HyperSnap 2

Site 
license:

$750 or $300 upgrade from HyperSnap 2 site license
(Site licenses cover a single organization for an area of up to one 
hundred miles (160 km) in radius.)

World-
wide 
license:

$2000 or $700 upgrade from HyperSnap 2 world-wide license

The price is the same for the Basic and Pro versions, and if you currently have a Basic version, you may 
upgrade for free at any time to Pro by downloading the Pro version from our Web site.

You may register your copy of HyperSnap-DX in one of the following ways:
· On the World-Wide Web in our Web Store http://www.hyperionics.com, which accepts all major 

credit cards. If you buy your license there, you will get a temporary registration within a few minutes.
Permanent license will arrive by email, usually the same or next day.

· Off-line by email, fax or snail-mail. To do so, please run the small Register program that comes with 
HyperSnap-DX and fill out all required fields there.    Then either email its output to us, or print it and
fax or send by snail-mail, as instructed on that form. Credit card numbers on the form and in email 
will be encoded for security. If you are sending us a check, please note that we can accept only checks
that are drawn on a US or Canadian based banks. You can also click on "Registration" in the button 
bar above to access the Register program.

· Use our International Distributors. For the most up to date list of International distributors see 
Hyperionics web page http://www.hyperionics.com. For the list of distributors active at the time of 
this release (March 1998) click here.

You may also mail your check or money order directly to the address below, payable to Greg Kochaniak. 
Important: the check or money order must be drawn on a US or Canadian bank, otherwise we cannot 
accept it. If you do so, please remember to add a short letter that tells us what you are ordering and 
where/to whom should we send the license.

Greg Kochaniak
Hyperionics
3146 Chestnut Street
Murrysville, PA 15668, USA

e-mail: gregko@hyperionics.com
http://www.hyperionics.com

                



 License, Distribution, and Vendor Information



 Hyperionics    International Distributors

For the most current list of Hyperionics international distributors, please visit our Web site at 
http://www.hyperionics.com. This list can be of particular interest to those who need to pay with a check. 
Hyperionics can only accept checks drawn on a US bank, but you may use local checks with our 
distributors. At the moment of this release (May 1999) the list of our international distributors includes 
(countries listed in alphabetical order):

Australia Shareware-Australia
http://www.shareware-australia.com
Click here for full address and off-line registration form for Australian users.

Germany Sharible (HyperCam in Germany is sold under WinCorder name)
Vogel Datentechnik
sharible Leserservice
Masurenweg 1
D-85521 Ottobrunn, Germany
phone and fax (ISDN) is: +49 +89 6085 1220
http://www.sharible.de/software/hyperionics/

Japan OddieSoft
Email: esteban@oddie.com
http://www.oddie.com/prod02.htm

The Netherlands BTSoftware BV Shareware Registration & Distribution
(serves also France P.O Box 4911
and Belgium) 5604    CC Eindhoven

The Netherlands
Fax: +31 40 290 6460
Email: Info@BTSoftware.com
Web:    http://www.btsoftware.com

Poland CreamSoftware, Poland
http://www.creamsoft.com

United Kingdom Grey Matter Ltd.
Prigg Meadow, Ashburton
Devon, UK. TQ13 7DF
Tel: +44 (0)1364 654 100
Fax: +44 (0)1364 654 200
Email: maildesk@greymatter.co.uk
http://www.greymatter.co.uk htm. 



 HyperSnap-DX  License, Distribution,    & Vendor Info
Note: all references to HyperSnap-DX Pro are not valid for DEC Alpha versions of this software. On DEC Alpha 
processors, only Basic version of HyperSnap-DX is available.

DISCLAIMER - AGREEMENT

Users of HyperSnap-DX must accept this disclaimer of warranty: "HyperSnap-DX is supplied as is.    The 
author disclaims all warranties, expressed or implied, including, without limitation, the warranties of 
merchantability and of fitness for any purpose. The author assumes no liability for damages, direct or 
consequential, which may result from the use of HyperSnap-DX."

Note: the information below does not apply to the owners of HyperSnap-DX commercial versions.

The trial version of HyperSnap-DX is provided at no charge to the user for evaluation.    Feel free to share it
with your friends, but please do not give it away altered or as part of another system.    If you find this 
program useful and find that you are using HyperSnap-DX and continue to use HyperSnap-DX after a 
reasonable trial period, you must make a registration payment. 

Commercial users of HyperSnap-DX must register and pay for their copies of HyperSnap-DX within 30 
days of first use or their license is withdrawn.    Site-License arrangements may be made by contacting 
Hyperionics.

Anyone distributing HyperSnap-DX for any kind of remuneration must first contact Hyperionics at the 
address below for authorization. This authorization will be automatically granted to distributors recognized 
by the (ASP) as adhering to its guidelines for shareware distributors, and such distributors may begin 
offering HyperSnap-DX immediately (However Hyperionics must still be advised so that the distributor can
be kept up-to-date with the latest version of HyperSnap-DX.).

OMBUDSMAN STATEMENT

Greg Kochaniak is a member of the Association of Shareware Professionals (ASP).    ASP wants to make 
sure that the shareware principle works for you.    If you are unable to resolve a shareware-related problem 
with an ASP member by contacting the member directly, ASP may be able to help.    The ASP Ombudsman 
can help you resolve a dispute or problem with an ASP member, but does not provide technical support for 
members' products. Please write to the ASP Ombudsman at 157-F Love Ave., Greenwood, IN 46142 USA, 
FAX 317-888-2195, or send email to omb@asp-shareware.org. 

Microsoft, DirectX, 3Dfx, GLIDE, and any other copyrighted or trademarked names used in this 
documentation file are the property of their respective owners.



 HyperSnap-DX  Tutorial
Note: all references to HyperSnap-DX Pro are not valid for DEC Alpha versions of this software. On DEC Alpha processors, only 
Basic version of HyperSnap-DX is available.

This Tutorial can walk you through some of HyperSnap-DX's basic steps and many options available to 
you. It assumes you are familiar with Windows 9x or NT and its basic operations.

Text Highlighted and Underlined like this is hyperlinked to further information about the topic. When you 
see text like this, if you are interested in that particular section, you should click it for further details.

The best way to learn is by doing. Try the exercises using HyperSnap-DX; you will benefit from the 
experience. You can print this tutorial by clicking on this text; you may find it easier to follow.

1. HyperSnap-DX offers three basic styles of screen captures. You should first decide which will be 
best for the task at hand.

Full Screen captures the
entire screen.

Window is a very 
flexible and convenient 
method where 
HyperSnap-DX outlines 
screen sections, like 
windows, automatically, 
making them easy to 
capture.

Region lets you outline 
any screen area that you 
need to capture.

 No matter what you select, you can always use HyperSnap-DX's crop function (within the Image Menu) to 
further edit your capture.

2. In order to view HyperSnap-DX and your capture after it has been done, make sure that the 
Restore After Capture option under the Capture menu is checked. If it is not checked, HyperSnap-DX 
will be minimized (go to the task bar) and you will have to click on it to open it up again. It's not a big deal,
but now you know what that option does.

3. Let's try a capture using the Window capture option. We will need a target application to capture so 
Click here to open Windows Explorer or, for NT users, File Manager,    if one of them isn't already open. If 
HyperSnap-DX isn't already open, Click here to open HyperSnap-DX.

4. Read all these steps before you proceed with the capture so you can follow them without referring 
to this file. You can optionally print this tutorial by clicking here if you haven't already.

1. When you are ready to begin, make sure that HyperSnap-DX is the top-most window; Windows 
Explorer should be directly beneath. Whatever window or area you want to capture should always
be visible.

2. Next, you will select Window from beneath the Capture menu and click on it. HyperSnap-DX 
will disappear, out of your way, down to the taskbar.

3. Move your cursor to different sections of the Explorer window. As you move it, notice that the 
blinking highlighted areas change. If you move to the Title Bar, the whole window is highlighted 
-- take your time and see all your options. Do you notice depending on where you move in the file
windows you can include or exclude the sliding bar?

4. Once you have highlighted an area you want to continue to experiment with, click your left 
(primary) mouse button.



 You can also use HotKeys to initiate your captures. We'll talk about that at the end of this Tutorial.

5. After HyperSnap-DX takes the screen shot, its program window, with your capture, is restored to your 
view. You can change HyperSnap-DX's window size like any other program if you want to see more of the 
capture.

6. At this point, if you were satisfied with the capture, you could save it or do other things with it, but let's 
try the handy crop feature first (within the Image Menu). Cropping lets you edit your capture further by 
selecting an area within it to keep, while discarding the rest. Like before, read all these bulleted steps 
before you proceed with the capture so you can follow them without referring to this file:

The first thing you will do is click on Crop from the Image menu. Your cursor will again turn into a 
little plus sign (+); notice how the coordinates of your position are displayed in the program's title bar. 

Now, Move it to the location that you will want as one corner of the section of the capture that you 
want to save and click your left mouse button. That will anchor one corner of the area you will crop 
from the capture.

Continue to move around, experiment with all that you can do. Without touching a mouse button, 
strike the minus or dash (-) key. Now, you can see the size, in pixels, that the cropped area will be. 
Hitting the key again will make the size go away. Pressing the F1 key will show you all the other 
options at your fingertips; you can click here for further crop information right now if you want more 
details on the function, or wait until later.

Now, move your cursor to enclose the area that you want to remain, and click your left mouse button. 
The capture is cropped per your specifications.

Remember, if the HyperSnap-DX windows doesn't show all of the necessary parts of the image, you 
can resize the window or scroll to the appropriate area.

If you choose Undo from the Edit menu, it will undo the action and restore your original capture.

 The Region Capture action, when you select it, works very similarly except it affects the whole screen. Now 
you have experience with how that method of capture works, too.

7. Now it's time to save your capture. As before, read each of these steps before you proceed with the 
capture, so you can follow them without referring to this file.

1. First, click on the Save As selection under the File menu to get a familiar-looking dialog. 

2. The Save as type window displays Windows Bitmap by default, and we'll use that one. However, 
you can choose from any of the other file types, some of which will give you further sub-format 
choices. 

3. Other choices for Bits Per Pixel let you specify the color depth, and additional options in with 
window are also activated when other file types are chosen. Click on the Help button, and an 
explanation for each of these options is provided for your reference.

4. You may want to take a moment to choose other file formats from the Save As dialog, and check 
how the options available change for each of them.

5. Once you have chosen your file type and options, use the usual means of filling in a file name and
navigating to the folder in which you want to save it, and click OK. Your capture is now saved.

 You can also copy your capture to the Windows Clipboard, and by using the Copy Format selection under the
Edit menu item, you can choose the color density of the image that is copied.



8. You have completed this Tutorial, but HyperSnap-DX has more ways of operating and features for your 
use. The QuickHelp image map that shows all of the HyperSnap-DX menu items is a great way to learn 
about them. Just click on each menu item for an explanation.

Here are some additional topics that you will find of interest:

Hotkeys can also be used to initiate a capture. 

HyperSnap-DX can be minimized to the taskbar, and out of your way, but it's always ready to spring into 
action.

Click on the Capture Menu item. Note the hotkey combinations assigned to each of the three types of 
captures. If you strike any of those combinations while HyperSnap-DX is minimized, it will become active 
and capture the screen using the method you selected.

You can change the hotkey assignments to ones that you prefer by selecting Configure Hot Keys from the 
Options menu item.

Did you know that HyperSnap-DX can be used as a handy graphics tool?

Use the Open selection from the File menu item to load an image file into HyperSnap-DX. Now you can...

Convert from one file format to another using the Save As selection under the File menu item, 
using all of the options available for each format. Yes -- that means you can convert one format to 
another, such as a standard BMP file to a progressive JPEG or a GIF with a transparent 
background, ready for web posting! The installation of the  version brings the number of 
supported file formats to over twenty. 

Copy the graphic to the Windows Clipboard in the number of colors you select.

Crop the graphic to just the right size, or crop out an image section -- HyperSnap-DX can even 
show you the area's size in pixels as you make your selection. Use the crop feature and press the (-) 
key.

Resize captures or image files you open in HyperSnap-DX when you install the  version.

Change the color depth of an image to 2, 16, 256, or 16 million colors, with eight dithering choices, 
or grayscale or halftone images when you install the  version.

See Also...
 Include Cursor Image
 Quick Crop & Scale
 Quick Save
 Quick Print
 Quick Copy
Enable Special Captures
 
 version 



 HyperSnap-DX    Tips and Hints
Note: all references to HyperSnap-DX Pro are not valid for DEC Alpha versions of this software. On DEC Alpha processors, only 
Basic version of HyperSnap-DX is available.

This section includes good ideas on how to approach certain captures using HyperSnap-DX. Do you 
have a unique solution for a problem using HyperSnap-DX? Help your fellow users -- send it to the author 
for use in the next release's hints and tips section.

How can you capture a drop-down menu or other program feature that disappears when you press 
the HyperSnap-DX hot key or menu item?

Iconize HyperSnap-DX to the taskbar, and then use one of its hot keys (e.g. Region or Window 
capture) to get the menu - it shouldn't disappear then.

Alternatively, if it does disappear, you can press the Print Screen key on your keyboard to send the
entire desktop to the Windows Clipboard. Now, place the shot in HyperSnap-DX by using the Edit|
Paste menu selection. Using the Crop feature will let you select the portion of the image you need.

You can take and use captures with HyperSnap-DX without ever seeing the program! Maybe this 
technique or a variation will be helpful to you.

Set HyperSnap-DX's options to Quick Copy from the Capture menu, and check off Restore after
capture under the same menu item. Now, go to your word processor or other application and 
proceed with your work. When you need a capture, use the appropriate HyperSnap-DX hot key. 
The options selected will cause the capture to be sent to the Windows Clipboard, so you can 
simply paste it into your document.

 If you need a reminder for which hot key to press, click on HyperSnap-DX in the task bar with your right 
mouse button, and select the type of capture you want.
How to capture games using MS DirectX and 3Dfx GLIDE technology

You must Enable Special Captures options under the Capture menu of HyperSnap-DX. Next, run 
the program or game normally, and whenever you're ready to capture the screen, use the hot key 
assigned to DX captures (Scroll Lock, by default). A short beep should sound to confirm the 
capture. HyperSnap will not force itself to the foreground interrupting the game, so if you want to 
see it, you have to use Alt-Tab key in the game to put it in the background and go back to regular 
Windows. Note: for some games Alt-Tab does not work; you will have to exit the game completely
to return to the Windows desktop.

You may set Quick Save or Quick Print in HyperSnap-DX before going into the game. Now, each 
time you capture a screen, it can be saved to a file with a sequential number or printed, so you 
need not leave your game to save or print your capture. The Quick Save feature also allow you to 
repeat a capture every 'x' seconds.



 HyperSnap    Set AutoScroll Refresh Time
Use the Options / Set AutoScroll Refresh Time menu item to change the time (in milliseconds) that 
HyperSnap-DX waits in Window Capture mode with auto-scroll for the window to refresh its contents in 
the newly scrolled-in region. If you use auto-scrolling and notice that parts of the picture are incorrect or 
missing, this means that the window you are capturing did not have enough time to refresh its contents after
each scroll. Increasing this time value may help in these situations. On other occasions you may want to 
decrease this value to make auto-scroll work faster. Reasonable values for auto-scroll refresh time are from 
20 to 1000 milliseconds.

 AutoScroll 



 HyperSnap    Command Line Options
Note: all references to HyperSnap-DX Pro are not valid for DEC Alpha versions of this software. On DEC Alpha processors, only 
Basic version of HyperSnap-DX is available.

HyperSnap-DX command line options:

-install does the installation
-uninstall uninstalls HyperSnap, deletes the license too

-QuickSave turn on "QuickSave" option, even if it was turned off in previous sessions.
Additional -QuickSave options to start with timed auto-save, e.g.

hsdx -hidden -QuickSave,5000,1,5 -snap:w:320:h240 -save:bmp f:\tmp\test 
hsdx -iconic -QuickSave,5000,1,5 -snap:w:320:h240 -save:bmp f:\tmp\test
hsdx -QuickSave,5000,1,5 -snap:w:320:h240 -save:bmp f:\tmp\test

will start with hidden, iconic or opened window, repeat the snap every 5000 ms (5 sec), 
increment the file name starting counter at 1 and do will stop when the counter reaches 5 
(see below for -snap and -save options description).

To disable adding numbers to the file name, set the second number in -QuickSave to 0, 
e.g.    -QuickSave,5000,0,5 - this will save snap 5 times to the same file.    Do disable max
count (the last number), set it to 0.    The capture will be repeated indefinitely, or until 
stop capture hot key (default F11) is pressed.

-fixed_title display a fixed title "HyperSnap-DX" only (do not display file name or picture size in the 
window title bar - may be needed if you want to "send keys" to HyperSnap window from 
Visual Basic or other application).

-hidden run with HyperSnap window hidden, operate with with hot keys only (must have set 
Quick Print, or Quick Copy earlier, or used with QuickSave to be useful)

-nosavedir HyperSnap-DX will not save the last used disk directory (folder) when you exit it. On the
next run of the program, it will use the value previously saved in the registry.

-nosetdir HyperSnap-DX will not restore the disk directory (folder) used in the previous run of the 
program - it will start instead with the current directory set according to the link property 
used to start the program, or current directory if started from command prompt window.

-dumpopts read from the registry and dump (save) HyperSnap options to hsdx.ini file.

-readopts read options from hsdx.ini file and save them in the registry.

-initfrom:filename This option may be used when starting HyperSnap-DX like:
hsdx -initfrom:c:\HySnap\hsdx2.ini 
where hsdx2.ini is the initialization file (with hot keys etc.) for HyperSnap-DX. Normally
it would read the options from the registry. This feature allows you to have multiple 
configurations with different settings. 
The initial copy of the ini file may be created with
hsdx -dumpopts
command line switch.

-snap capture screen (or a portion) one time only, to immediately print or save it, then exit. 
HyperSnap Window is not displayed. Takes several sub-options separated with : (colon).

hsdx -snap:x60:y150:w200:h100 -save:bmp test.bmp
:x is X pixel coordinate to start the capture from, counted from the left. If omitted, 0 is 



assumed.
:y is Y pixel coordinate to start the capture from, counted from the top. If omitted, 0 is 

assumed.
:w is width of the area to capture, in pixels. If omitted, the area from :x to the right 

edge of the screen will be captured
:h is height of the area to capture, in pixels. If omitted, the area from :y to the bottom of

the screen will be captured.
:window allows the user to select with the mouse the window to capture
:region allows the user to select with the mouse a rectangular region to capture
:awin will capture the currently active window, including frame and title
:acli will capture the currently active window without the title and frame ("client area")

-open:[filename] will open and read the specified file (must have a supported file extension and be valid 
graphics file in that format). Then will perform the action specified by the next option (-
print or -save - possibly in a different format) and exit. May be used to print several 
graphics files in batch mode, or to translate file between different supported formats, e.g.

To translate test.bmp to test.gif:
        hsdx -open:test.bmp -save:gif test.gif
To print test.jpg file to the default system printer:
        hsdx -open:test.jpg -print 
      

-print may be used after -snap option to cause print of the captured picture. Takes several sub-
options separated with : (colon).

:l      print in Landscape mode. Default it portrait
:inv invert black and white
:bw    print black and white colors only
:fr    draw a frame around printed picture
:sNN scale, where NN is % of the size, default is 100%
:af    auto-fit the picture to fill the whole page
          (but preserving the aspect ratio)
:pd    display Print Dialog, to select the printer etc.
          Prints to the default printer if :pd omitted.
Example:

hsdx -snap -print:l:fr:s75
will snap the whole screen and print in landscape mode
with a frame and scaled to 75% of the original size. 
          

-save may be used after -snap option to save the picture to a supported file type. Next argument 
should be file name, snap.bmp, snap.gif or snap.jpg is assumed if file name is not 
specified. Sub-options:

:gif        save as GIF file
:gif:i    save as Interlaced GIF file
:jpg save as JPEG file with default quality of 75%
:jpg:qNN save as JPEG file with quality NN% (replace NN
                    with a number, e.g. 90).
:jpg:p save as progressive JPEG file (:qNN may also be added)
:bmp        save as BMP file (this is default, may be 
                omitted). Bitmap pixel depth is the same as screen's.
:bmp:c1    save as 1 bpp bitmap
:bmp:c4    save as 4 bpp bitmap
:bmp:c8    save as 8 bpp bitmap
:bmp:c24 save as 24 bpp bitmap 

Other file types are also accepted here if you have HyperSnap-DX Pro installed. Here is a
list of all file types accepted:

bmp, gif, jpg, tif, cmp, cal, fax, eps, img, raw, ica, pict, mac, msp, pcx, ras, tga, 



wfx, vfm, wpg, png, psd, avi
With all these file types the following options are accepted, if valid for a given file type:
:a append picture to the specified file, if file format permits this (e.g. GIF, TIFF, 
AVI)
:c1, :c4, :c8, :c24 - color resolution
:i, :p interlaced or progressive.
:qNN quality in %, valid for jpg and cmp files

Examples:
Snap the whole screen and save in BMP file

hsdx -snap -save c:\tmp\test.bmp
Snap portion of screen, save as 8 bit per pixel bitmap:

hsdx -snap:x50:y80:w200:h100 -save:bmp:c8 btm.bmp 
Snap the whole screen, save to GIF file:

hsdx -snap -save:gif test.gif
Snap the whole screen, save to JPEG file with 85% quality

hsdx -snap -save:jpg:q85 test.jpg

-ddesrv HyperSnap-DX runs as DDE server when started with this option. Currently the only 
DDE commands that the program executes (XTYP_EXECUTE DDE call in C, or 
LinkExecute in Visual Basic) are load filename and activate. If you run a second copy of 
HyperSnap-DX with this switch (when the first one was run the same way), it will only 
activate and bring to front the first copy, and the second one will exit instantly. If you run 
a second copy like this:
hsdx -ddesrv filename
it will cause the first copy to load the picture stored under filename and activate/bring to 
front that copy. The second copy, after sending the appropriate DDE command, will exit 
instantly.



 HyperSnap-DX  What's New
Note: all references to HyperSnap-DX Pro are not valid for DEC Alpha versions of this software. On DEC Alpha processors, only 
Basic version of HyperSnap-DX is available.

Click on any of the buttons or help hotspots below to learn more about the HyperSnap-DX feature 
mentioned.    

 New!    Capture screens from applications and games using Microsoft's new DirectX or 3Dfx GLIDE 
technology. In the past, these screens either could not be captured or captured only with incorrect coloring, using 
standard screen capture technology. Our new DX Snap technology solves this problem for you. Capture your 
moments of glory in these virtual worlds, share them with friends, put on your web pages!

 New!    Dock or float the toolbar to the most convenient location
 New!    Crop a rectangle from within an image and replace it with a color of your choice.
 New!    Undo and revert commands for easy reversal of undesirable image edits
 New!    Send by Email lets you conveniently use your default mail program to send a capture
 New! Free upgrade to 
 version for…
· TWAIN Compatibility for your scanner, digital camera, or other compatible device 
· Additional File Format support to bring the total to over twenty popular file formats!
· Resizing Images using easy to use slide controls along with percentage and pixel displays, image aspect 

control, and interpolation
· Changing Color Depth up or down to 2, 16, 256, or 16 million colors with eight dithering choices, plus 

grayscaling or halftones. 

Check out HyperCam, another quality product from Hyperionics, that allows you to record the action from
your Windows 9x or NT screen as an AVI movie. You can include cursor movements and sound, and take 
advantage of many other options, designed with the same care as HyperSnap-DX. Find out more about 
HyperCam and download a trial version from our web site at http://www.hyperionics.com

Scribbler 98 - software product sold by Hyperionics. This is a unique DHTML and JavaScript editor, 
written by Cream Software



HyperSnap-DX Pro Version
Note: all references to HyperSnap-DX Pro are not valid for DEC Alpha versions of this software. On DEC Alpha 
processors, only Basic version of HyperSnap-DX is available.

The  version is a powerful free upgrade for the registered users of basic HyperSnap-DX. When you 
download and install it, new menu items and expanded features are added to your favorite screen capture 
program, enhancing its image capture, editing, and file conversion capabilities.

 TWAIN Compatibility – use your scanner, digital camera, or other compatible device to interface with 
HyperSnap-DX 

 Additional File Formats – In addition to BMP (DIB), GIF, and JPEG, add TIFF, LEAD (cmp), CALS, 
CCITT Fax (fax), Encapsulated Postscript (eps), GEM Image (img), IBM IOCA (raw), Macintosh Picture (pic, pict),
MacPaint (mac), Microsoft Paint (msp), OS/2 Bitmap (bmp), SUN Raster (ras), Targa (tga), WinFax (wfx), 
Windows Metafile (wfm), WordPerfect (wpg), Portable Graphics PNG, and Adobe PSD. Many types have sub-
formats that let you even further refine your image file. And it not only can save in these file formats, but is able to 
open all these files and AVI videos, too, making it a powerful and convenient conversion tool.

 Image Resizing – Use interactive controls to change the physical size of your capture, or any image file 
you open in HyperSnap-DX. Easy to use slide controls along with percentage and pixel displays help you achieve 
the size you need. You can also retain the image aspect, and use interpolation to improve the resized image.

 Image Colors – Change the color depth of your image up or down to 2, 16, 256, or 16 million colors, and 
use any of eight dithering choices. Or, choose to grayscale or halftone the image if you're printing monochrome 
output.

Undo and revert commands are included so changes to image sizes and colors can be applied, but 
reversed if the results are not pleasing.

This file can be downloaded from the Hyperionics Web Site, http://www.hyperionics.com and other popular
archive sites.

 If currently a popup window, open this topic as a regular Help page.



 HyperSnap-DX  Other Hyperionics Software
    

Visit the Hyperionics Web Site at http://www.hyperionics.com to download trial and free versions of our other 
software products:

 Check out HyperCam, another quality product from Hyperionics, that allows you to record the action 
from your Windows 95 or NT screen as an AVI movie. You can include cursor movements and sound, and 
take advantage of many other options, designed with the same detail and care as HyperSnap-DX. 

Scribbler 98 - software product sold by Hyperionics. This is a unique DHTML and JavaScript editor, 
written by Cream Software



Australian Order Form
Please print this page, then fill out and send as instructed. 
Hyperionics products are available in Australia/New Zealand from our 
local distributor Shareware-Australia. 

The price of HyperSnap-DX is Australian $ 40.00
The price of HyperCam is Australian $ 50.00

Postage and handling is FREE - please note that you are only buying a 
licence code, that will fully enable the version of Hyperionics software
you already have. The licence code will be delivered by email if 
possible, or else by fax or snail-mail.

Note: Site Licence pricing is available. Please contact us for details.
You can order by phone, fax, email, or postal mail.

Fax your order to (02) 9565-2362
Phone your order to (02) 9565-2339
Email your order to sales@shareware-australia.com
Visit our web site http://www.shareware-australia.com
Mail your order to Shareware-Australia

PO Box 1075
Maroubra NSW 2035

Payment can be made by Cheque, Money Order, Bankcard, Mastercard, 
Visacard, or American Express.  

Name:_____________________________________________________

Address: _________________________________________________

Address2: ________________________________________________

Phone: ____________Fax: ____________ Email: ______________

Paid by Cheque/Money Order [ ]  Credit Card [ ]

Credit Card No. ___________________________________________

Expiry Date: __________  Signature: _______________________

Please supply

__ copies of HyperSnap-DX @ AU$50 each $______

__ copies of HyperCam @ AU$60 each $______
Postage & Handling FREE

Total $______




